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1 Introduction

1.1 Overview

MQMR-GUI application allows the user to create or update MQMR IniFiles.  MQMR-GUI can run on
any platform that supports Java v1.6 (or higher): Linux, Mac OS X and Windows Vista/7/8/8.1/10. 

MQ Message Replication (MQMR) will clone messages being written (via MQPUT or MQPUT1 API 
calls) to an application's output queue and MQMR will write the exact same messages to 'n' target 
queues ('n' can be up to 100).  When MQMR replicates a message both the message data and the 
message's MQMD structure will be cloned.  This means that the fields of the MQMD structure (i.e. 
PutTime, MessageId, CorrelId, UserId, etc..) will be exactly the same as the original message's MQMD
structure.

The MQAdmin can configure MQMR to perform message replication on any number of queues.  The 
application messages put to each queue can be replicated and put to (up to) 100 target queues.

MQMR can clone messages being written to any MQ queue type.  i.e. local, alias, remote and/or 
cluster queues (including transmission queues).

Existing applications do not need to be modified or updated nor is it necessary to set up 
Publish/Subscribe to use MQMR.  MQMR is deployed and configured at the queue manager level; 
hence, no application changes are required.

MQMR is an MQ API Exit that operates with IBM MQ v7.1, v7.5, v8.0, v9.0, v9.1 and v9.2 in 
Windows, Unix, IBM i (OS/400) and Linux platforms.  
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2 Installation
This chapter will describe the installation and configuration (optional) of MQMR-GUI. For Windows 
users, the installation of MQMR-GUI is very simple and straightforward. Other Operating Systems 
will need to unzip the downloaded software package.

2.1 Prerequisites
This section lists the required hardware and software components needed to run the MQMR-GUI 
application. 

2.2 Software
The following third party software components must be installed in order to properly run MQMR-GUI:

 Java Runtime Environment (JRE) 1.6 (or higher) or Java 2 SDK, Standard Edition (J2SE) v1.6 
(or higher) 

2.3 Hardware / OS
MQMR-GUI is capable of running on the following hardware platforms that support Java v1.6 (or 
higher): 

 Linux
 Mac OS X
 WindowsVista, 7, 8, 8.1 & 10

2.4 Setting Up and Running the Application
The following section provides instructions on installing and running the MQMR-GUI application.

2.4.1 For Windows Users:

 Run the install program called: mqmrgui-setup-withjre.exe 

 The installer should follow the standard Windows install procedures and provide default values
for the users. 

 When the install program has installed MQMR-GUI, there will be a newly created folder under 
Start -> All Programs called MQMR-GUI. 

 To run MQMR-GUI, select the MQMR-GUI icon from within the MQMR-GUI folder. 
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2.4.2 For Linux and Max OS X (requires JRE/JDK):

 MQMR-GUI is provided as a zip file: mqmrgui.zip 

 To unzip the file, open a shell prompt and execute the following commands: 

unzip mqmrgui.zip 

 When the unzip command has finished, there should be a directory tree as follows: 

Capitalware/MQMR-GUI 

 Change directory by typing the following:

cd Capitalware/MQMR-GUI 

 Before running MQMR-GUI for the first time, you need to add the execute attribute to the 
mqmrgui.sh shell scripts. Type the following: 

chmod +x mqmrgui.sh 

 To run MQMR-GUI from the Capitalware/MQMR-GUI directory, then type the following: 

./mqmrgui.sh 
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3 Creating / Updating IniFiles
This chapter will describe the how to create and/or update IniFiles.

3.1 New IniFile
This section will describe how to create a new MQMR IniFile. The IniFile can be for a local or remote 
MQMR implementation. 

From the main menu of MQMR-GUI, select File then New File 

The following is the New IniFile panel: 

Fill in the following information: 
 Input a file name including the file extension of '.ini'
 Select the Operating System
 Choose between a 32-bit or 64-bit environment

Finally, click the Ok button to create and open the new MQMR IniFile.
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3.2 Open an IniFile
This section will describe how to open a MQMR IniFile to be viewed or edited. The IniFile can be for 
a local or remote MQMR implementation. 

From the main menu of MQMR-GUI, select File then Open File 

The following is the Open dialog box: 

Select the IniFile that you wish to view / edit and then press the Open button.
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3.3 Close an IniFile
This section will describe how to close a MQMR IniFile. 

From the main menu of MQMR-GUI, select File then Close 

If the user has altered the IniFile then the user will be presented with the following dialog box: 
Select Yes to save the changes otherwise select No. 

The MQMR-GUI program will make a backup of the original file in the same directory and call it: 
{inifilename}.backup
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3.4 Save IniFile
This section will describe how to save an open MQMR IniFile. 
From the main menu of MQMR-GUI, select File then Save 

The parameter information will be saved to the IniFile. 

The MQMR-GUI program will make a backup of the original file in the same directory and call it: 
{inifilename}.backup
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3.5 Save As IniFile
This section will describe how to save an open MQMR IniFile. 
From the main menu of MQMR-GUI, select File then Save As 

Select or Input the IniFile name that you wish use then press the Save button. 
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4 Tabs
This chapter will describe the various parameters on each tab.

4.1 General Tab
This section will describe various parameters on the General tab of a MQMR IniFile. 
The following is a General Tab with default values: 

The IniFile keywords and their values on the General Tab are discussed below.
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4.1.1 General
This section describes the general keywords and their values.

 Active controls enabling or disabling MQMR.

 Description parameter is optional and is not used by MQMR.  It can be used to provide a brief 
description / purpose of the IniFile. 

 License key is provided by Capitalware Inc. The license is for a particular queue manager. 
Your license will look something like: 1000-AAAA-BBBBBBBB (Note: This is a sample license only 
and will NOT work). 

 LicenseFile specifies the location of License file that contains all of the customer's license 
keys.  The following are the default values for LicenseFile:

• For Windows: C:\Capitalware\MQMR\mqmr_licenses.ini
• For IBM MQ 32-bit on Linux: /var/mqm/exits/mqmr_licenses.ini
• For IBM MQ 64-bit on Unix and Linux: /var/mqm/exits64/mqmr_licenses.ini
• For IBM i: /QIBM/UserData/mqm/mqmr/mqmr_licenses.ini

 AddSourceInfo specifies if MQMR is will add the source queue and queue manager name to 
the message as a message property.  AddSourceInfo supports 2 values [Y / N].  The default value is N.

 IniFileRecheckTime specifiies how often the MQMR IniFile will be read.  Default is 60 
seconds.

 ExitPath explicitly sets the API exit path.

4.1.2 UserID Handling
This section describes the necessary entries on how to handle the incoming UserID.  

 UserIDFormatting supports 3 values [A / U / L]. ('As Is, Uppercase and Lowercase).  The 
default value is A.
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4.1.3 Logging
This section describes the keywords related to logging and their values.

 LogMode specifies what type of logging the user wishes to have. LogMode supports 4 values: 
Quiet, Normal, Verbose and Debug. The default value is Normal. 

 LogFile specifies the location of the log file. The default is as follows: 
• For Windows: C:\Capitalware\MQMR\mqmr.log 
• For IBM MQ 32-bit on Linux: /var/mqm/exits/mqmr.log 
• For IBM MQ 64-bit on Unix and Linux: /var/mqm/exits64/mqmr.log
• For IBM I: /QIBM/UserData/mqm/mqmr/mqmr.log

 
 RotateLogDaily specifies whether or not MQMR when auto-rotate the log files.  The default 
value is Yes.

 BackupLogFileCount specifies the number of backup log files to be kept / retained.  The 
default value is 9.

MQMR-GUI User Guide          Page 11



4.2 Filters Tab
This section will describe various parameters on the Filters tab of a MQMR IniFile. 

The following is the Filters Tab with sample values: 

The following are the IniFile parameters on the Filters Tab: 
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4.2.1 Exclude Filters
This section describes the Exclude Filter keywords and their values.

 UseExcludesApplications allows the user to specifically exclude applications from the 
encryption / decryption processing.

 ExcludesApplications explicitly specifies which applications should not be protected by 
MQMR.

 UseExcludesUserIDs allows the user to specifically exclude UserIDs from the encryption / 
decryption processing.

 ExcludesUserIDs explicitly specifies which UserIDs should not be protected by MQMR.
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4.3 Queues To Replicate Tab
This section will describe various parameters on the Queues To Replicate tab of a MQMR IniFile. 

The following is the Queues To Replicate Tab with sample values: 
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This section describes IniFile keywords that the user will use so that MQMR will perform message 
replication against a queue.

4.3.1 Managing the Queues
This section describes the necessary steps to manage the queues:

Click the Add button to add an entry to the list. 

Input the queue name (wildcards are not allowed) and then click the Ok button. 

Click the Rename button to delete an entry in the list. 

Update the queue name then click the Ok button.

Click the Delete button to delete an entry in the list. 

Click the Yes button to permanently remove the entry from the list. 
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Click the Edit button to update an entry in the list. 

4.3.1.1 Settings
This section describes the settings for the particular queue.

 Context indicates how MQMR will handle the clone message's MQMD.  Context supports 2 
values [Set/Default].  The default value is 'Set'.

• Set means that MQMR will set the context of the clone message's MQMD to be the same as the
original message's MQMD.

• Default means that MQMR will use the default context for the clone message's MQMD.

 UseExpiry indicates if MQMR will overwrite the cloned/replicated message's Expiry value.  
The original message's Expiry value is NOT altered.  UseExpiry supports 2 values [Y/N].  The default 
value is N.

 Expiry value (in milliseconds) used by MQMR to set the cloned/replicated message's Expiry 
value.  The original message's Expiry value is NOT altered.  The default value is '-1' 
(MQEI_UNLIMITED).

 ForMQPut1DoMQPut1 indicates how MQMR will put a message to the target queues when 
an application uses MQPUT1 to put a message to the application's output queue.  
ForMQPut1DoMQPut1 supports 2 values [Y/N].  The default value is Y.

 AddSourceInfo specifies if MQMR is will add the source queue and queue manager name to 
the message as a message property.  AddSourceInfo supports 2 values [Y / N].  The default value is N.
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 UseSyncPoint specifies if MQMR should perform the MQPUT of the cloned message to the 
targets queues under a SyncPoint (unit of Work).  UseSyncPoint supports 2 values [Y / N].  The 
default value is N.

 CollapseMQMDE specifies that MQMR should change the MQMD version from 1 to 2 (of the
cloned message), move the MQMDE values from the embedded MQMDE structure and then remove 
the embedded MQMDE structure.  CollapseMQMDE supports 2 values [Y / N].  The default value is 
N.

 TargetQueues keyword specifies a list of target queues.  Separate each target queue with a 
semi-colon ';'.

4.3.1.2 Clear Report Options

 ClearRO indicates how MQMR will handle the message’s MQMD Report Option field. 
ClearRO supports 2 values [Yes/No].  The default value is 'No'.  Note: CleaRO keyword takes 
precedence over the other ClearRO*** fields.

 ClearROCOA indicates how MQMR will handle the message’s MQMD Report Option field.  
ClearROCOA supports 2 values [Yes/No].  The default value is 'No'.

 ClearROCOD indicates how MQMR will handle the message’s MQMD Report Option field.  
ClearROCOD supports 2 values [Yes/No].  The default value is 'No'.

 ClearROPAN indicates how MQMR will handle the message’s MQMD Report Option field.  
ClearROPAN supports 2 values [Yes/No].  The default value is 'No'.

 ClearRONAN indicates how MQMR will handle the message’s MQMD Report Option field.  
ClearRONAN supports 2 values [Yes/No].  The default value is 'No'.

 ClearROException indicates how MQMR will handle the message’s MQMD Report Option 
field.  ClearROException supports 2 values [Yes/No].  The default value is 'No'.

 ClearROExpiration indicates how MQMR will handle the message’s MQMD Report Option 
field.  ClearROExpiration supports 2 values [Yes/No].  The default value is 'No'.

4.3.1.3 Skip Report Message

 SkipCOA indicates how MQMR will handle a message with MQMD Feeback field set to 
MQFB_COA. SkipCOA supports 2 values [Yes/No].  The default value is 'No'.

 SkipCOD indicates how MQMR will handle a message with MQMD Feeback field set to 
MQFB_COD. SkipCOD supports 2 values [Yes/No].  The default value is 'No'.

 SkipPAN indicates how MQMR will handle a message with MQMD Feeback field set to 
MQFB_PAN. SkipPAN supports 2 values [Yes/No].  The default value is 'No'.
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 SkipNAN indicates how MQMR will handle a message with MQMD Feeback field set to 
MQFB_NAN. SkipNAN supports 2 values [Yes/No].  The default value is 'No'.

 SkipExpiration indicates how MQMR will handle a message with MQMD Feeback field set to
MQFB_EXPIRATION. SkipExpiration supports 2 values [Yes/No].  The default value is 'No'.
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5 Other Tools
This chapter will describes how the other tools included with MQMR-GUI.

5.1 Hex Converter
This section will describe how to invoke and use the Hex Converter tool. Hex Converter tool can 
convert a hexadecimal number to its corresponding string representation and vice versa. i.e. 
0x'3132333041424344' to '1230ABCD'.

For the Other Tools, you can have unlimited number of them running (up to what your box can 
support). Also, while any of the Other Tools are running, the user can still use MQMR-GUI.

From the main panel of MQMR-GUI, select Tools, then Hex Converter.

This is the main panel of the Hex Converter.

• The user first selects the Conversion type: "Hex to Character" or "Character to Hex"
• Input the value hex or character value into the "Input Value" field
• Click the Convert button to convert the data
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5.2 Hex Editor
This section will describe how to invoke and use the Hex Editor tool. The Hex Editor is a simple 
multipurpose hex editor. The Hex Editor supports multi-file editing.

For the Other Tools, you can have unlimited number of them running (up to what your box can 
support). Also, while any of the Other Tools are running, the user can still use MQMR-GUI.

From the main panel of MQMR-GUI, select Tools, then Hex Editor.

This is the main panel of the Hex Editor and it has 3 open files.

Supported features:
• Open / editing of multiple files
• Recent File List
• Copy, Find and Find Next
• Save, Save As and Print
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5.3 Tail File
This section will describe how to invoke and use the Tail File tool. The Tail File is a simple 
multipurpose file monitoring viewer. The Tail File supports monitoring of multiple files at the same 
time.

For the Other Tools, you can have unlimited number of them running (up to what your box can 
support). Also, while any of the Other Tools are running, the user can still use MQMR-GUI.

From the main panel of MQMR-GUI, select Tools, then Tail File.

This is the main panel of the Tail File and it has 3 open files.

Supported features:
• Opening of multiple files
• Wrap Text and Recent File List
• Copy, Find, Find Next and Print
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5.4 Text Editor
This section will describe how to invoke and use the Text Editor tool. The Text Editor is a simple 
multipurpose plain-text editor. The Text Editor supports multi-file editing.

For the Other Tools, you can have unlimited number of them running (up to what your box can 
support). Also, while any of the Other Tools are running, the user can still use MQMR-GUI.

From the main panel of MQMR-GUI, select Tools, then Text Editor.

This is the main panel of the Text Editor and it has 3 open files.

Supported features:
• Open / editing of multiple files
• Builtin XML Viewer, Wrap Text
• Recent File List
• Cut, Copy, Paste, Find and Find Next
• Save, Save As and Print
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The following shows the Text Editor's builtin XML Viewer.
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5.5 Visual Difference
This section will describe how to invoke and use the Visual Difference tool. The Visual Difference is a
simple file to file comparison tool.

For the Other Tools, you can have unlimited number of them running (up to what your box can 
support). Also, while any of the Other Tools are running, the user can still use MQMR-GUI.

From the main panel of MQMR-GUI, select Tools, then Visual Difference.

This is the main panel of the Visual Difference. To initiate the file comparison process, click File and 
then click Compare File to File

First the user needs to select the first file for the comparison.
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Next, the user needs to select the second file for the comparison.

The following shows the difference between 2 files. Differences are highlighted: Green for inserts, Red
for deletions and Blue for changes.
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5.6 XML Editor
This section will describe how to invoke and use the XML Editor tool. The XML Editor is a simple 
multipurpose plain-text editor. The XML Editor supports multi-file editing.

For the Other Tools, you can have unlimited number of them running (up to what your box can 
support). Also, while any of the Other Tools are running, the user can still use MQMR-GUI.

From the main panel of MQMR-GUI, select Tools, then XML Editor.

This is the main panel of the XML Editor and it has 3 open files.

Supported features:
• Open / editing of multiple files
• Recent File List
• Copy, Find and Find Next
• Save, Save As and Print
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6 Miscellaneous
This chapter will describes how the miscellaneous features of MQMR-GUI.

6.1 Language
This section will describe how to switch MQMR-GUI's Language Text to another Language Text. 
MQMR-GUI has been designed to support Java's multi-language environment.  Currently, MQMR-
GUI has language support (menu items, buttons and titles) for the following 55 languages:

 Amharic (am)
 Arabic (ar)
 Azerbaijani (az)
 Bengali (bn)
 Cebuano (ceb)
 Chinese (China) (zh)
 Chinese (Taiwan) (zh)
 Czech (cs)
 Danish (da)
 Dutch (nl)
 English (en)
 Finnish (fi)
 French (fr)
 German (de)
 Greek (el)
 Gujarati (gu)
 Hausa (ha)
 Hebrew (iw)
 Hindi (hi)

 Hungarian (hu)
 Igbo (ig)
 Indonesian (in)
 Italian (it)
 Japanese (ja)
 Javanese jv)
 Kannada (kn)
 Korean (ko)
 Malay (ms)
 Malayalam (ml)
 Marathi (mr)
 Norwegian (no)
 Panjabi (pa)
 Pashto (ps)
 Persian (fa)
 Polish (pl)
 Portuguese (pt)
 Romanian (ro)
 Russian (ru)

 Shona (sn)
 Sindhi (sd)
 Spanish (es)
 Sundanese (su)
 Swahili (sw)
 Swedish (sv)
 Tamil (ta)
 Telugu (te)
 Thai (th)
 Turkish (tr)
 Ukrainian (uk)
 Urdu (ur)
 Uzbek (uz)
 Vietnamese (vi)
 Xhosa (xh)
 Yoruba (yo)
 Zulu (zu)

From the main panel of MQMR-GUI, select View, then Language.
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6.2 Reset View
This section will describe how to reset the view of MQMR-GUI if the display is not correct.

The user can also reset the view from the command line by passing in the RG parameter.

6.2.1 Windows Command Line
On Windows, issue the following command to reset the view of MQMR-GUI:

mqmrgui.exe  RG

6.2.2 Linux and macOS Command Line
On Linux and macOS, issue the following command to reset the view of MQMR-GUI:

./mqmrgui.sh  RG
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7 Appendix A – Frequently Asked Questions (FAQ)

Q. Can IniFiles be create on Windows for MQMR on Unix?
A. Yes. Once the IniFile has been saved, the user can copy or ftp (in ASCII mode) 
the file to the remote server.
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8 Appendix B – MQMR-GUI Upgrade Procedures
To upgrade an existing installation of MQMR-GUI, please do the following in the appropriate section 
below.

8.1 Windows Upgrade
 Stop all instances of  MQMR-GUI
 Backup any MQMR-GUI data files in the MQMR-GUI install directory
 Go to the Windows Control Panel and select Program and Features
 Select MQMR-GUI and then click the Uninstall button
 Run the install program called: mqmrgui-setup-withjre.exe
 The installer follows the standard Windows install procedures and provides default values for 

the user.
 When the install program has completed execution, there will be a newly created folder under 

Start -> All Programs called MQMR-GUI.
 Restore the MQMR-GUI data files if necessary
 To run MQMR-GUI, select the MQMR-GUI icon from within the MQMR-GUI folder.

8.2 Linux or macOS Upgrade
 Stop all instances of  MQMR-GUI
 Backup any MQMR-GUI data files in the MQMR-GUI install directory
 Remove the installation i.e. rm -Rf Capitalware/MQMR-GUI/
 Unzip the file, open a shell prompt and execute the following commands: 

unzip mqmrgui.zip 

 When the unzip command has finished, there should be a directory tree as follows: 

Capitalware/MQMR-GUI 

 Change directory by typing the following:

cd Capitalware/MQMR-GUI 

 Before running MQMR-GUI for the first time, you need to add the execute attribute to the 
mqmrgui.sh shell scripts. Type the following: 

chmod +x mqmrgui.sh 

 To run MQMR-GUI from the Capitalware/MQMR-GUI directory, then type the following: 

 ./mqmrgui.sh
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9 Appendix C – Support
The support for MQMR-GUI can be found at the following location:

By email at:
support@capitalware.com

By regular mail at:

Capitalware Inc.
Attn: MQMR-GUI Support
Unit 11, 1673 Richmond Street, PMB524
London, Ontario  N6G2N3
Canada
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10 Appendix D – Summary of Changes

 MQMR-GUI v2.2.0
o Rearranged the fields on the General tab.

 MQMR-GUI v2.1.0
o Added the ‘Recent Files’ menu option under the File menu option.
o Added images to buttons for more user-friendly display.
o Added support for 55 languages for the menu options, buttons and titles (not IniFile 

keywords).
o Added the ‘Reset View’ menu option under the View menu option.
o Added 6 tools under the Tools menu option: 

 Compare File to a File
 Hex Converter
 Hex Editor
 Tail File
 Text Editor
 XML Editor

 MQMR-GUI v2.0.0
o Added the ability to clear the MQMD Report Options field - new keywords: ClearRO, 

ClearROCOA, ClearROCOD, ClearROPAN, ClearRONAN, ClearROException & 
ClearROExpiration

o Added the ability to skip messages with the MQMD Feedback field set to particular 
values - new keywords: SkipCOA, SkipCOD, SkipPAN, SkipNAN & SkipExpiration

o Added the ability to use SyncPoint for cloned messages - new keyword: UseSyncPoint

 MQMR-GUI v1.2.0
o Added the ability to exclude applications - new keywords: UseExcludeApplications & 

ExcludeApplications
o Added the ability to exclude UserIDs - new keywords: UseExcludeUserIDs & 

ExcludeUserIDs
o Added UserIDFormatting flag to force lowercase/uppercase/as_is UserID formatting on

all platforms

 MQMR-GUI v1.0.1
o Added new keyword AddSourceInfo which will add the source queue manager name 

and queue name to the cloned message as message properties

 MQMR-GUI v1.0.0
o Initial release.
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11 Appendix E – License Agreement
This is a legal agreement between you (either an individual or an entity) and Capitalware Inc. By 
opening the sealed software packages (if appropriate) and/or by using the SOFTWARE, you agree to 
be bound by the terms of this Agreement. If you do not agree to the terms of this Agreement, promptly 
return the disk package and accompanying items for a full refund.
SOFTWARE LICENSE

1. GRANT OF LICENSE. This License Agreement (License) permits you to use one copy of the 
software product identified above, which may include user documentation provided in on-line or 
electronic form (SOFTWARE). The SOFTWARE is licensed as a single product, to an individual 
queue manager, or group of queue managers for an Enterprise License. This Agreement requires that 
each queue manager of the SOFTWARE be Licensed, either individually, or as part of a group.  Each 
queue manager's use of this SOFTWARE must be covered either individually, or as part of an 
Enterprise License. The SOFTWARE is in use on a computer when it is loaded into the temporary 
memory (i.e. RAM) or installed into the permanent memory (e.g. hard disk) of that computer. This 
software may be installed on a network provided that appropriate restrictions are in place limiting the 
use to registered queue managers only.  Each licensed queue manager will be provided with a perpetual
license key and the licensee may continue to use the SOFTWARE, so long as the licensee is current on
the Yearly Maintenance Fee.  If the licensee stops paying the Yearly Maintenance Fee, then the 
SOFTWARE must be removed from all systems at the end of the current maintenance period.

2. COPYRIGHT. The SOFTWARE is owned by Capitalware Inc. and is protected by United States Of 
America and Canada copyright laws and international treaty provisions. You may not copy the printed 
materials accompanying the SOFTWARE (if any), nor print copies of any user documentation 
provided in on-line or electronic form. You must not redistribute the registration codes provided, either
on paper, electronically, or as stored in the files mqmr.ini, mqmr_licenses.ini or any other form.

3. OTHER RESTRICTIONS. The registration notification provided, showing your authorization code 
and this License is your proof of license to exercise the rights granted herein and must be retained by 
you. You may not rent or lease the SOFTWARE, but you may transfer your rights under this License 
on a permanent basis, provided you transfer this License, the SOFTWARE and all accompanying 
printed materials, retain no copies, and the recipient agrees to the terms of this License. You may not 
reverse engineer, decompile, or disassemble the SOFTWARE, except to the extent the foregoing 
restriction is expressly prohibited by applicable law.

LIMITED WARRANTY

LIMITED WARRANTY. Capitalware Inc. warrants that the SOFTWARE will perform substantially 
in accordance with the accompanying printed material (if any) and on-line documentation for a period 
of 365 days from the date of receipt.

CUSTOMER REMEDIES. Capitalware Inc. entire liability and your exclusive remedy shall be, at 
Capitalware Inc. option, either (a) return of the price paid or (b) repair or replacement of the 
SOFTWARE that does not meet this Limited Warranty and that is returned to Capitalware Inc. with a 
copy of your receipt. This Limited Warranty is void if failure of the SOFTWARE has resulted from 
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accident, abuse, or misapplication. Any replacement SOFTWARE will be warranted for the remainder 
of the original warranty period or thirty (30) days, whichever is longer.

NO OTHER WARRANTIES. To the maximum extent permitted by applicable law, Capitalware Inc. 
disclaims all other warranties, either express or implied, including but not limited to implied warranties
of merchantability and fitness for a particular purpose, with respect to the SOFTWARE and any 
accompanying written materials.

NO LIABILITY FOR CONSEQUENTIAL DAMAGES. To the maximum extent permitted by 
applicable law, in no event shall Capitalware Inc. be liable for any damages whatsoever (including, 
without limitation, damages for loss of business profits, business interruption, loss of business 
information, or other pecuniary loss) arising out of the use or inability to use the SOFTWARE, even if 
Capitalware Inc. has been advised of the possibility of such damages.
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12 Appendix F – Notices

Trademarks:

AIX, IBM, MQSeries, OS/2 Warp, OS/400, iSeries, MVS, OS/390, WebSphere, IBM MQ and z/OS 
are trademarks of International Business Machines Corporation.

HP-UX is a trademark of Hewlett-Packard Company.

Intel is a registered trademark of Intel Corporation.

Java, J2SE, J2EE, Sun and Solaris are trademarks of Sun Microsystems Inc.

Linux is a trademark of Linus Torvalds.

Mac OS X is a trademark of Apple Computer Inc.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation.

UNIX is a registered trademark of the Open Group.

WebLogic is a trademark of BEA Systems Inc.
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